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Informativa :
HEXEL electronics s.r.l.u. si riserva il diritto di poter cambiare le specifiche  
hardware e software descritte in questo manuale in qualsiasi momento senza 
obbligo di comunicazione .
Il programma di controllo SMDVISIO 1.x.x funziona solo con Windows10 o 
successivo.
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1) Descrizione Generale

La SMDVISIO è un sistema semiautomatico per l'ispezione ottica del corretto 
assemblaggio dei componenti SMD o PTH su scheda elettronica.

La SMDVISIO permette la semplificazione delle operazioni relative all'ispezione 
del circuito stampato fornendo assieme l'immagine ingrandita del 
componente , i dati del componente ricavati dalla tabella di montaggio ( il 
nome , il valore , le coordinate , la rotazione ecc.. )  e un'immagine campione 
precedentemente acquisita dalla scheda campione.

Dalla comparazione tra queste informazioni si puo' facilmente verificare la 
correttezza dell'assemblaggio. 

La SMDVISIO e' un ottimo supporto alla certificazione di qualita' essendo il 
controllo effettuato direttamente da un operatore qualificato ed evitando cosi' 
le incertezze legate al controllo automatico soggette a variabili imponderabili.

2) Ambiente di lavoAmbiente di lavoro 
 
2.1)La SMDVISIO e' progettata per l'uso in ambienti  civili . Se non viene     
        utilizzata e' opportuno tenere la macchina in un ambiente protetto da 

polvere ed umidita' 

2.2) Non esporre la SMDVISIO alla pioggia o all'umidita'.

2.3) Posizionare la SMDVISIO  su superfici solide ,non inclinate  ed asciutte.
       Lasciare lo spazio opportuno attorno alla macchina  (min. 10 cm). 

3)   Caratteristiche 

Peso netto: 18 kg circa
Peso lordo: 20 kg circa con l'imballo
Dimensioni: 600×500×200 mm
Massime dimensioni del PCB in ispezione: 360 mm x 270mm
Precisione di posizionamento: 0,2mm
Dimensioni compreso l'imballo: 670×580×280 mm
Tensione di alimentazione: 12VDC, 24W (da alimentatore fornito assieme)
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4) Dichiarazione CE  

Produttore: HEXEL S.R.L.U. - TRISSINO (VI) ITALY
Descrizione del prodotto: sistema semiautomatico per 

l'ispezione delle schede elettroniche 
Tensione di alimentazione: 12VDC, 24W
Modello: SMDVISIO

La SMDVISIO e' progettata secondo le seguenti direttive e standard:

Directives:
2014/35/EU   Low Voltage Directive (LVD) 
2004/108/EC EMC Directive 
2011/65/EU   EU RoHS Directive 

Standards:
IEC/EN 61010-1:2010 

Safety requirements for electrical equipment for measurement, control, and laboratory use 
IEC/EN 61326-1:2013

Electrical equipment for measurement, control and laboratory use. EMC requirements. 
General requirements

5) Targa identificativa

MODEL:  SMDVISIO 
Input Power:  12V / 2A
Producer: HEXEL s.r.l. - ITALY 
S/N: 00001/2018 
Made in ITALY

 
Questo simbolo indica che SMDVISIO in caso di 

      dismissione deve essere conferita agli enti  
competenti per lo smaltimento o in alternativa 
puo' essere conferita al produttore che 
provvedera' al corretto smaltimento.
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6) Precauzioni di sicurezza

Leggere attentamente le seguenti note sulla sicurezza prima di utilizzare 
SMDVISIO.

6.1) Il produttore non e' responsabile per ogni eventuale danno a cose o
a persone dovuto ad un uso scorretto o improprio del macchinario.

6.2) La SMDVISIO puo' essere usata solo da personale qualificato all'uso.

6.3) L'installazione e' per  superfici piane orizzontali.

6.4) E' vietata qualsiasi manomissione o modifica .

6.5) Prima di dare tensione verificare che tutte le parti sotto tensione siano 
integre.

6.6) E' vietato riparare o modificare la SMDVISIO . In caso di danneggiamento 
richiedete il nostro intervento scrivendo a :  info@hexel.it.

6.7) La SMDVISIO non e' un giocattolo. Tenere i bambini a distanza. 

6.8) Temperatura ambientale massima: +40°C (104°F).

6.9) Temperatura ambientale minima: +15°C (41°F).

6.10) I PCB non possono essere maneggiati da bambini.  

6.11) I motori elettrici della SMDVISIO hanno parti magnetiche che possono 
compromettere apparecchiature con parti sensibili ai campi magnetici  
(carte di credito , hard disk , badge ecc..). Mantenere tali  
apparecchiature distanti dalla SMDVISIO.  

NOTE: se siete portatori  di pacemaker consultate il vostro medico prima 
dell'utilizzo di SMDVISIO.
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7) Componenti della SMDVISIO

Asse Y sul lato destro 
1. Potenziometro di regolazione della luminosita' della telecamera

    Regolazione della luminosita' dei led della telecamera .

Pannello posteriore

1. Connettore USB Tipo B (camera port)
     Connettore usb per la telecamera della SMDVISIO.

2. Connettore di alimentazione DC 12V/2A
    Connettore di alimentazione tipo: 5.5mm/2.1mm. Si raccomanda di 

utilizzare l'alimentatore a 12V/2A fornito assieme alla macchina
   SMDVISIO .

3. Connettore USB Tipo A (service port)
    Connettore usb per la comunicazione tra  SMDVISIO ed il PC.
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8) Uso del software

Requisiti di sistema

Sistema operativo : WINDOWS 10

programma per la lettura dei documenti PDF: reader for .pdf file

Processore: 1 GHz o maggiore
RAM: 1 GB (32-bit) or 2 GB (64-bit)

Hard Disk raccomandato: SSD minima taglia  500GB 
Spazio libero richiesto sull'hard disk : 16 GB (32-bit) o 20 GB (64-bit)
Scheda grafica : high speed card, 16 million colors, min. 4 GB DDR3

Monitor: 1024×768 minimum 

Com Port: almeno due porte USB tipo A libere

E' richiesta la connessione ad internet per accedere al manuale on_line  

9) Installazione del software SMDVISIO 1.x.x

9.1)  Inserire il CD o la PEN_USB fornite con la macchina , aprire la cartella 
<publish>, fare doppio click sul programma SETUP.

       Attendere l'installazione.

       Connettere i due cavi USB della SMDVISIO al PC.

       Lanciare il programma SMDVISIO cliccando sull'icona. Il programma 
rilevera' automaticamente le porte di connessione. 

9.2) Service port.
      Se appare il messaggio "Port not found" verificare la corretta connessione 

del cavo USB. Se il cavo risulta correttamente inserito verificare la 
corretta installazione del software driver . Se I driver risultano 
danneggiati o assenti rieseguire l'installazione dei driver secondo le 
specifiche del sistema operativo in uso.
Generalmente nello start di Windows si cerca il "device manager", si 
cerca nel disco/pennetta di installazione la cartella   

     <CP210x_VCP_Windows>e si lancia una nuova installazione.
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9.2)  Camera port.
Se l'installazione della telecamera e' corretta aprire il menu' 
Setup > Preferencies > Camera e selezionare la telecamera della 
macchina.
Se non viene mostrata la telecamera della SMDVISIO verificare ed 
eventualmente rieseguire l'installazione dei driver della telecamera 
secondo le specifiche del sistema operativo in uso..

Generalmente nello start di Windows si cerca il "device manager", si 
cerca nel disco/pennetta di installazione la cartella   

     <CAMERA\Driver> e si lancia una nuova installazione.
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10) Funzionamento del software  SMDVISIO 1.x.x

10.1) Alimentare la SMDVISIO .

10.2) Connettere il cavo della service port al PC .
           

10.3) Connettere il cavo della telecamera (camera port) al PC .
         

10.4) Lanciare il programma con un doppio click sull'icona SMDVISIO  
         (smdvisio.exe).

Appare la schermata :
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11) Descrizione dell'interfaccia
11.1) Menu' della barra superiore - File

                                      user manual

      Doc. Id :  190504                               04-05-2019       smdvisio.it

Open : apertura e importazione file cad
Save as : salva il file come data file  
               (extension .vis)

       Viene salvato solo il file compreso 
il fiducial e la sua posizione   

Export as : esporta il file in formato CSV
utilizzabile per la tracciabilita'
per industria 4.0

Open project : apre i file di progetto 
             (extension .vspj). Vengono caricati

i dati, le foto e i fiducial
 Save project: salva  i file di progetto 
             (extension .vspj). Vengono salvati 

i dati, le foto e i fiducial . 
Il progetto richiede il nome 
dell'operatore ed il numero di 
lotto.

Save report as : salva il file come report per 
la golden card (extension .rpt) 
Salva il file come golden card da 
confrontare  e viene caricato con 
il bottone Load Report button   

Compare Files : compara il file vecchio con il
nuovo file e genera una tabella 
con le differenze : 
COMPONENTI TOLTI -> 
RIGA COLORE MARRONE CHIARO
COMPONENTI AGGIUNTI -> 
RIGA COLORE VERDE CHIARO
COMPONENTI MODIFICATI-> 
RIGA COLORE GIALLO 
Richiede il fiducial di riferimento  

Export Wrong Components:  esporta la 
lista dei componenti spuntati nella 
colonna WRONG



11.2) File -> Open: apertura dei  file cad ( estensioni .mnt or .txt or .vis ) 
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Open file – Loading File Parameters

File type :

Selezione del tipo di file da importare

Invert X Axis :

Inverte le coordinate dell'asse X

Invert Y Axis :

Inverte le coordinate dell'asse Y

Value Separators : 

I file forniti dal programma cad possono 
avere fino a  tre tipi di separatori : 

spazio o tab o altro ( ad es ,   ;    :  ) .

File Headers : 

I file forniti dal programma cad possono 
avere fino a 6 campi . Si puo' selezionare 
l'ordine delle intestazioni agendo sulla 
selezione  N X Y R V P , per saltare un 
campo usare J .

Measurement Unit :

L'unita' di misura del file puo' essere in 
mm o mils.

Multiple Electronic Boards : 

E' possibile verificare anche circuiti multipli
impostando la selezione  a Yes e indicando
in “Number of boards” il numero di circuiti 
in x e il numero di circuiti circuiti in y).



11.2.1)Importazione file cad  
File ->  Open ->   si apre il menu' Loading File Parameters 

File Type : opzioni per i tipi di file cad
All files  per i file cad generici
.rpt   per i file cad generati da SMDVISIO 
        con la golden card. Questo file permette di 

importare le modifiche apportate al file cad 
originale durante l'ispezione della golden card
e di replicarle nel circuito multiplo.   

Invert Axis : opzioni per l'origine cartesiana del file cad :
 se l'origine e' in basso a sinistra non flaggare nulla

se l'origine e' in alto a destra flaggare  Invert X Axis e Invert Y Axis
se l'origine e' in basso a destra flaggare  solo Invert X Axis   

   se l'origine e' in alto a sinistra flaggare  solo Invert Y Axis

Value Separators  : opzioni per i separatori del file cad
File Headers : opzioni per la definizione delle colonne del file cad

esempio di riga di file cad 

R49 93.98 59.05 270 22K FEEDER19 R0805
R49 nome del componente   ->  N

 93.98   valore della quota X ->   X
59.05   valore della quota Y ->   Y
270   rotazione del componente -> R
22K  valore del componente ->  V
FEEDER19  colonna non utilizzata -> J
R0805 package del componente -> P
Il File Headers sara' : N,X,Y,R,V,J,P
Se ci sono delle colonne non utilizzate usare il comando J per 
non importare la colonna     

Measurement Unit : opzione per quote in mm o mils 

Multiple Electronics Boards :  opzione per circuito multiplo
scegliere no per il circuito singolo o per fare la golden card. 
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Multiple Electronics Boards :  opzione per circuito multiplo
Scegliere Yes se il circuito e' multiplo . Il circuito multiplo 
deve essere in sequenza consecutiva , non e' previsto il 
circuito mirror o altre varianti. Impostare il numero di circuiti 
presenti in X ed in Y considerando il quadrotto come una 
tabella .       

              PCB n.3

 Ѳ  fid.ref.

              PCB n.4

 Ѳ  fid.ref.

              PCB n.5

 Ѳ  fid.ref.

              PCB n.0

 Ѳ  fid.ref.

              PCB n.1

 Ѳ  fid.ref.

              PCB n.2

 Ѳ  fid.ref.

Terminata la configurazione confermare con il bottone OK in basso.
Se la configurazione e' corretta il programma popola la tabella dati con i 
valori del file cad e la macchina si posiziona sullo zero . 
Il programma chiede di scegliere la riga con il  Ѳ fid.ref 
( puo' anche essere un componente) e di confermare con il bottone

   Select As Fiducial

quindi chiede di posizionarsi in JOG sul fiducial della scheda in basso a 
sinistra (Ѳ fid.ref. PCB n.0) , confermare con il bottone  

Set Fiducial Position

e poi in alto a destra (Ѳ fid.ref. PCB n.5) e confermare ancora con  
      Set Fiducial Position

Vengono presentati tutti i fiducial delle schede e richiede la conferma della corretta 
posizione per ogni fiducial.  Se non e' stato selezionato il circuito multiplo verra' 
eseguita solo l'acquisizione del primo fid.ref. (Ѳ fid.ref. PCB n.0) . 

                                      user manual

      Doc. Id :  190504                               04-05-2019       smdvisio.it



 11.3)Setup ->  Preferencies   
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Select Marker: scelta delle 
         dimensioni del 

Marker
Select Camera: scelta della 

        telecamera
Select Com: scelta della  

    com port
Insert Multiplier X : 

ratio of x axis
Insert Multiplier Y: 

ratio of y axis
Max jog value X: quota massima 

                 asse x
Max jog value Y: quota massima 

asse y
Jog movement value: minimo 

passo (mm)
Offset Zero X : offset per la 

posizione di zero 
     dell'asse X 

Offset Zero Y : offset per la 
       posizione di zero 
     dell'asse Y 

Delay Autoshot : ritardo tra una
foto e l'altra
durante
l'Autoshot.

Zoom : imposta lo zoom
della telecamera

Import : carica I valori di 
setup salvati in 
precedenza

Export : esporta I valori di
setup attuali.

Restore Default : ripristina i 
valoridi fabbrica

Save :  salva le selezioni attuali



11.3) Tools ->  Gymn
Test meccanico , inserire quota di partenza (0-0), quota di arrivo 
( 100-100) e cliccare sull'icona Gymn per iniziare , cliccare 
nuovamente per fermare.  

Tools ->  Clear error
Se e' presente un allarme   cliccare su Clear error per 
resettare l'errore.
Ripetere l'operazione se l'allarme si ripresenta .

Tools -> Duplicate Component 
Duplica la riga attuale 
( Tasto destro del mouse ->  Duplicate  oppure  CTRL+C). 

Tools -> Erase Component 
Cancella la riga attuale 
( Tasto destro del mouse ->  Erase oppure  CANC ). 

Tools -> Assign Current Position
Aggiorna la quota del componente della riga attuale alla quota attuale
per visualizzare particolari del componente altrimenti fuori campo 
visivo 
(Tasto destro del mouse ->  Assign Current Position). 

11.4) Info-> 
    Board info: informazioni sulla release della scheda di controllo

            Firmware info: informazioni sulla release del  firmware
    Website: smdvisio.it
    Manual: link al manuale on line  o off line se non e' disponibile il 
    servizio wifi 
    About Us: informazioni su HEXEL srl
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12) Descrizione dei bottoni software

Set Fiducial Position: 

Zero Machine: 

Go To Fiducial: 

Go To Components: 

Live View: 

Shots:

Jog :

Select as Fiducial: 

Move: 

Ricerca automatico dello zero macchina.

Modalita' di ispezione attraverso le foto acquisite della scheda  
elettronica.
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Conferma la posizione del fiducial centrato con la telecamera.

Spostamento automatico alla posizione del fiducial acquisito.

Spostamento al componente selezionato sulla tabella dati.

Modalita' di ispezione visiva immediata della scheda elettronica .

Modalita' di movimento manuale con l'uso delle frecce sul programma 
o sulla tastiera.

Conferma la selezione della riga di tabella come fiducial di 
riferimento.

Frecce per il movimento della telecamera. E' 
possibile usare le frecce del programma o della 
tastiera.
Per muovere di 0.1mm premere le freccia .
Per muovere di 2mm premere SHIFT e freccia .
Per muovere di 6mm premere CTRL e freccia .



Next Board:

Prev.Board:

Zoom+ :

Zoom- :

AUTO SHOT area

Start (Pause):

Stop:

Load Report:

Screen Shot:

Selezione del successivo PCB se selezionato circuito multiplo .

Zoom + aumenta lo zoom della telecamera .

Alterna lo start e la pausa della modalita'  di 
autoacquisizione delle foto ( AUTO SHOT )
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Selezione del precedente PCB se selezionato circuito multiplo .

Zoom - diminuisce lo zoom della telecamera .

Stop della modalita' di autoacquisizione delle foto ( AUTO SHOT )

Caricamento delle foto di riferimento precedentemente acquisite 
dalla Golden Card

Foto immediata del componente in ispezione . Le foto vengono 
salvate nella cartella SMDVISIO_Pictures  sul desktop.



13) Descrizione delle icone 
Busy:

Alarm:

Data Table: 

Picture: 

Report Picture: 

Components Data:

Visualizza l'immagine del componente in ispezione in 
due modalita' :

immediata  LIVE VIEW            dalla telecamera 

foto - SHOTS             dalle foto salvate nel progetto 
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Il programma e' impegnato  , non eseguire altre azioni .

Allarme attivo , verificare il nome dell'allarme sulla barra inferiore .
Per resettare l'allarme aprire il menu'  TOOL -> Clear Error

Tabella dei dati ( importati dal file cad )

Immagine del componente importata dalla galleria 
delle foto di riferimento con il bottone 
LOAD REPORT  (  file.rpt ) 

Valori del componente in ispezione ricavati dalla tabella 
dati



14) Descrizione della barra delle informazioni inferiore
Status bar : 

Durante il funzionamento la videata presente e' simile alla seguente:
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Working Time :  tempo trascorso durante l'acquisizione delle foto
Project no: nome del progetto
Autoupdate board No. :  numero della scheda in acquisizione nella sessione 

  in corso
Operator : nome dell'operatore
Batch :  numero del lotto  
File :  nome del file in uso
COM : numero della porta di comunicazione
Current X,Y : posizione attuale per l'asse X e Y



15) Appendice 

Power supply:
Productor: EDACPOWER
Model: EA1018G-1E
AC input: 100 – 240V~, 50/60Hz, 1A max
DC output: 12Vdc, 2A
Environment temperature: 5°C - 40° C (41°F - 104° F)
Power supply: 24W
For indoor use only

• CEC Compliance
• RoHS Compliance
• Plug USA, EU, SAA, UK Type
• Over Voltage Protective Installation
• Protection Type: Auto-Recovery
• MTBF: >30,000 hours



By HEXEL s.r.l.
v. Del Lavoro 41/B

36070 Trissino (VI) Italy
website : smdvisio.it

e-mail : smdvisio@hexel.it
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GARANZIA LEGALE DEL PRODOTTO 

1) HEXEL srl garantisce sui difetti di fabbricazione relativi ai prodotti 
forniti per un periodo di un (1) anno dalla data di fatturazione. 
Pertanto il periodo totale di garanzia legale ed sarà di 1 anno dalla 
data della fattura.

2) La garanzia è valida per i prodotti standard , sono esclusi 
dall'estensione i prodotti realizzati su specifica richiesta del cliente. 

3) La Garanzia è applicabile solo quando: 
3.1 l'installazione e/o il montaggio del Prodotto sono eseguiti in 
conformità alle istruzioni allegate al Prodotto e da personale 
tecnico specializzato; 
3.2 la manutenzione del Prodotto è eseguita da personale tecnico 
specializzato, non apportando modifiche o riparazioni ai Prodotti 
senza autorizzazione scritta di HEXEL srl o non contemplati nelle 
relative specifiche tecniche; 
3.3 i valori limite di temperature e tensioni non sono oltrepassati e 
il Prodotto non viene esposto a carichi meccanici non conformi alla 
destinazione dello stesso;
3.4 il difetto segnalato pregiudica la funzionalità del prodotto; 
3.5 in caso di presunto difetto, le condizioni del prodotto dovranno 
essere mantenute inalterate per l'esecuzione delle opportune 
verifiche; 
3.6 il prodotto difettoso deve inoltre essere messo a disposizione di
HEXEL srl per analisi tecniche e per tutto il tempo necessario per il 
loro svolgimento; 
3.7 il vizio, debitamente specificato e provato nella sua natura ed 
entità, deve essere denunciato per iscritto a HEXEL srl entro e non 
oltre trenta (30) giorni dalla data di ricevimento dei prodotti (in 
caso di difetti apparenti) o dalla scoperta del difetto (in caso di 
difetti occulti); 
3.8 il Cliente presenti la fattura comprovante l'acquisto e che abbia 
regolarmente pagato il Prodotto secondo quanto previsto nelle 
condizioni di vendita. 

4) La presente garanzia non include: 
4.1 Danni al prodotto dovuti a negligenza, al trasporto, ad eventi 
imprevisti e/o imprevedibili, quali caso fortuito e/o forza maggiore 
(compresi impulsi di corrente, fulmini), che escludano la 
riconducibilità di tali vizi al processo di fabbricazione del Prodotto 
(vandalismo, alterazioni non autorizzate e fenomeni atmosferici 
anomali); 
4.2 tutte le spese aggiuntive derivanti dalla riparazione del difetto: 
ad esempio costi di manodopera per montaggio e smontaggio, 
trasporto di prodotti difettosi e nuovi/riparati, smaltimento, 
rimborso spese, trasferte, elevatori o ponteggi saranno a carico del
cliente; 
4.3 I componenti soggetti ad usura che sono assimilabili a 
materiale di consumo (quali sorgenti luminose, parti meccaniche..) 



4.4 la presente garanzia non si applica se l'apparecchio non è usato
per lo scopo per cui è stato realizzato; 
4.5 la presente non garantisce l'integrità della verniciatura quando 
il prodotto viene utilizzato in un ambiente salino o in presenza di 
agenti corrosivi. 
5) Nel caso in cui il difetto sia coperto dalla presente garanzia, 
HEXEL srl sceglierà, a sua discrezione, tra la riparazione del 
prodotto difettoso e/o la sostituzione dello stesso con un articolo 
identico o equivalente, compatibilmente con l'evoluzione tecnica dei
prodotti e dei loro componenti. 
6) La garanzia di un (1) anno è valida anche per i prodotti che 
utilizzano una sorgente luminosa a LED
7) La responsabilità di HEXEL Srl per un difetto di prodotto sarà in 
ogni caso limitata alla somma pagata per quel prodotto difettoso. 
8)La presente garanzia si applica al mercato nazionale ed estero. 
9) In caso di controversia tecnica le parti sottoporranno il prodotto 
in contestazione a perizia da parte di esperto terzo - nominato di 
comune accordo o, in mancanza di accordo, dal Presidente del 
Tribunale di Vicenza. La valutazione dell’esperto sarà vincolante per
entrambe le parti. Le spese verranno sostenute dalle parti in 
misura del 50 % ciascuna. 
10) Per quanto non previsto dalle presenti condizioni si applica la 
legge italiana. Per qualsiasi controversia è esclusivamente 
competente il Foro di Vicenza. 
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